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Foreword 
 

This manual is a complimentary private work made from previous manuals , 

mainly the 201 6 version in PDF built by Kƃrlis Bruƨenieks,  and from some 
of the current Help pages (for version 19) of the SketchUp web site . 

 
The author has  no  links with Google or the Trimble Co mpany.  

 
This manual has been made  for the SketchUp community of users  to ease 

the learning of the application offline 1. It is  free for download 2.  

  
All  the text and images in this document are © 2019 Trimble, published 

with requested authorization.  
 

Should Trimble consider publishing this manual as an official Trimble 
document, the author will be more than happy to make his Word source file 

available.  
 

Warning :  This PDF file is in A4 format . A Letter  format is in works (all the 
pix have to be changed from free position  to bound - to - text  first ).  

 
This edition in P DF format , all additional text ( in blue )  and footnotes are     

© 2019 Didier Morandi. Corrections and suggestions are more than 
welcome via mail at didier.morandi@gmail.com . 

 

Toulouse  
October 23rd , 2019 . 

  

 
1 To be able to read it later on an iPad without Internet connection, download the PDF then 

open it with iBooks, a copy will be stored locally.  
2 File (PDF, 211 pages, 3.4 Mb) is available from 

htt p://www.didiermorandi.fr/SketchUp/SketchUp_User_Manual_v19 .pdf  

mailto:didier.morandi@gmail.com
http://www.didiermorandi.fr/SketchUp/SketchUp_User_Manual_v19.pdf
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User Interface 
 

¶ Welcome screen  

¶ Main screen  

¶ Toolbar s  

¶ Drawing Axes  

¶ Context Menu  

¶ Inference  

¶ Dialog Boxes  

 

Welcome screen 
 

Developed for the conceptual stages of design, SketchUp is a powerful yet 
easy - to - learn 3D software. We think of it as the pencil of digital design. 

This award -winning software combines a simple, yet robust tool -set that 
streamlines and simplifies 3D design inside your computer. SketchUp is 

being used by anyone with the desire to Dream, Design and Communicate 
in 3D!  

 
The Welcome to SketchUp dialog box appea rs when you first run 

SketchUp. This dialog box is primarily used to choose a template for use in 
SketchUp (templates have predefined settings, such as units of 

measurement), open an existing project , license a copy of SketchUp Pro, 
and learn more about Sk etchUp.  
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Legend of previous picture:  

 
1 -   Files Tab: Display templates to create a new model.  

2 -  Template List . Click to select.  
3 -  More Template Button : Click to display more templates.  

4 -  Learn Tab: Display options to learn SketchUp (Forum, Campus and 
Videos).  

5 -  Open fileé Button : Click to locate and open an existing project.  

6 -  Recent files : History list of previous projects.  
7 -  List formatting Button : Toggle recent files list (summary or details).  

8 -  Licen se Tab: Display licen se information.  
9 -  User Profile Button : User profile management and Sign Out option.  

 
 

Main screen 
 

 
 
The Main screen displays  the following Menu commands  :  

 

¶ File  

¶ Edit  

¶ View  
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¶ Camera  

¶ Draw  

¶ Tools  

¶ Windows  

¶ Help  

Below the Menu list are toolbars located.  
 

At the bottom of the screen, a sta tus bar displays the following buttons 
and information  :  

 

¶ Geo- location Button  

¶ Credits Button  

¶ Context sensitive description  

¶ Measurements Field  

 

Toolbars 
 
The toolbar s which appear below the menus and sometimes along the left 

side of the application contain a user -defined set of tools and controls. 
SketchUp displays only the Getting Started  tool palettes by default. To 

show or hide other tool palettes:  
 

1.  Select View > toolbar s.  The toolbar s sub -menu displays.  

2.  Select any toolbar to show or hide. toolbar s with a check mark are 

currently displayed. toolbar s without a check mark are not currently 

displayed.  
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Note: A right click on any toolbar displays the list of all toolbars.  

 

 
 

Note: Toolbars can be moved outside the screen of the SketchUp program 
onto the desktop, if the main SketchUp window is not resized to its 

maximum size.  

 
Advanced Camera Tools toolbar  

 
The buttons on the Advanced Camera Tools  toolbar  allow you to create a 

scene with multiple cameras (that have set  aspect ratios) which can be 
used to mimic a film set. The buttons activate the Create a physical 

camera with real world parameters  tool, Look through a camera  created 
by ócreate Cameraô, Lock/Unlock the current camera , Show/Hide all 

cameras  created by ócreate Cameraô, S how/Hide all camera frustrum s 
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lines , Show/Hide all camera frustrum  volumes , and Clear the aspect ratio 

bars and return to the default camera  tool . 
 

Camera toolbar  
 

The buttons on the Camera  toolbar  activate the Orbit tool, Pan tool, Zoom 
tool, Zoom Window tool,  Zoom Extents  tool , Previous, Position Camera 

tool, Look Around tool and  Walk tool .  

 
Classifier toolbar  

 
Display a pop -up menu to choose a classification system to load into the 

model .  
 

Construction toolbar  
 

The buttons on the Construction  toolbar  activate the Tape Measure tool, 
Dimensions tool, Protractor tool, Text tool, Axes tool, and  3D Text  tool.  

 
Drawing toolbar  

 
Display the Drawing toolbar.  

 

Dynamic Components toolbar  
 

The buttons on the Dynamic Components  toolbar activate the Interact  
with Dynamic Compoments  tool, Component Options dialog box , and  

Component Attributes dialog box . 
 

Edit toolbar  
 

The Edit  toolbar  contains geometry modification tools. The tools on this 
toolbar  are the Move tool, Push/Pull tool, Rotate tool, Follow Me too l, 

Scale tool, and Offset  tool.  
 

Getting Started toolbar  
 

 
 

Display the default toolbar.  
 

Large Tool Set toolbar  
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Located on the left side of the screen, the Large Tool Set  toolbar  display s 

a set of most commonly used tools.  
 

Layers toolbar  
 

The Layers  toolbar  provides quick access to several often used layer 
operations.  

 

Location  toolbar  
 

The buttons on the Location  toolbar  activate the Add Location tool, the  
Toggle Terrain tool  and the  Add Texture  tool.  

 
Measurements toolbar  

 
The Measurements  toolbar  contains a field where you can type values 

corresponding to the currently activated tool.  For example, you can type 
in the specific length of a line while you are in the Line  tool. The 

Measurement  toolbar  is used to create accurate geometry.  
 

Principal t oolbar  
 

The buttons on the Principal  toolbar  activate the Select tool, Make 

Component, Paint Bucket tool, and Eraser  tool.  
 

Sandbox toolbar  
 

The buttons on the Sandbox  toolbar  activate SketchUp's Sandbox tools 
(Sandbox From Contours, Sandbox From  Scratch,  Smoove tool, Stamp 

tool, Drape tool, Add Detail tool, and  Flip Edge tool ).  
 

Sections toolbar  
 

The Sections  toolbar  allows you to conveniently execute common section 
operations. The controls on this toolbar include buttons for toggling the 

section cut effect and toggling the display of section planes.  
 

Shadows toolbar  

 
The Shadows  toolbar  is used to control shadows. T his toolbar  contains 

buttons  to launch the Shadow Settings  dialog box (left -most icon) and 
enable/disable shadows (second icon). This toolbar  also contains slider 

bars to control settings related to the time of year (left -most slider bar) 
and time of day ( right -most slider bar).  
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Solid Tools toolbar  

 
The buttons on the Solid Tools  toolbar  activate the Outer Shell tool, 

Intersect tool, Union tool, Subtract tool, Trim tool, and  Split  tool.  
 

Standard toolbar  
 

The Standard  toolbar  contains a  variety of menu items which help with file 

and drawing management and shortcuts to printing and help operations. 
These menu items are New, Open, Save, Cut, Copy, Paste, Erase, Undo, 

Redo, Print, and  Model Info .  
 

Styles toolbar  
 

The buttons on the Styles  toolbar  activate SketchUp's face rendering 
styles (x - ray transparency, wireframe, hidden line, shaded, shaded with 

textures, and monochrome).  
 

Trimble Connect toolbar  
 

The Trimble Connect  toolbar  displays the Trimble Connect  buttons. To 
know more about Trimble Connect, please visit the Trimble Connect Web 

site pages at https://connect.trimble.com . 

 
Views toolbar  

 
The buttons on the Views  toolbar  activate SketchUp's standard views (iso, 

top, front, right, back, and left). The bottom view is not included, but is 
available from the Camera  menu.  

 
Warehouse toolbar  

 
The buttons on the Warehouse  toolbar  are used to collaborate between 

SketchUp 3D Ware house and Extension Warehouse. The  toolbar  contains 
the Get Models..., Share Models...., Share Component..., and  Extension 

Warehouse . If you have an extension/plugin installed that has an update 
available, the Extension Warehouse  icon will show a yellow circle with two 

circular arrows.  

 
Reset Button  

 
Allows a selected toolbar  to be reset to its default buttons.  

 
Reset All Button  

 
Allows a ll toolbar s to be reset to their default buttons.  

 

https://connect.trimble.com/
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New Button  

 
Creates an empty toolbar in which any button can be moved to.  

 
Rename Button  

 
Changes the name of a newly created toolbar.  

 

Delete Button  
 

Deletes a newly created toolbar.  
 

Close Button  
 

Close s the toolbar  control panel.  
 

Options Tab  
Show ScreenTips on toolbars  

 
If you hover your mouse over a toolbar, a "ScreenTip" with more 

information about the tool will appear  in a pop -up window and in the 
status line located in the bottom of the screen .  

 

You can choose whether or not SketchUp shows that information  in the 
pop -up window .  

 
Click the Options  tab then check the Show ScreenTips on toolbars  

checkbox to switch between showing the screen  tips in a pop -up window  
or not.   

 

Note: Screen tips are always displayed in the status line . 

 
Large Icons  

 
The toolbar  can be displayed using small and large tool buttons. Click the 

Options  tab then check the Large Icons  checkbox to switch between  small  
and large tool buttons.  
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Menu commands 
 

¶ File  

¶ Edit  

¶ View  

¶ Camera  

¶ Draw  

¶ Tools  

¶ Window  

¶ Help  

File  
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 

 
Edit  
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View  
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 

 
Camera  
 
 

 
 

 
 

Draw  
 

 
 
 

Tools  
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Window  
 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

Help  
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Drawing Axes 
 
The Global axis lines in SketchUp show the origin of the X,Y and Z axis. 

They are essential to see the orientation of your model.  
 

Determining which way is up, down, east, west, north, and south  
 

Each axis has a solid line on one side of the origin and a dotted line on the 
other side of the origin. Following is an explanation for each line that 

make up the origin:  

 

Å The solid blue line leads up from the origin.  

Å The dotted blue line leads down from the origin.  

Å The solid red line leads east from the origin.  

Å The dotted red line leads west from the origin.  

Å The solid green line leads north from the origin.  

Å The dotted  green line leads south from the origin.  

 
 

 
 

 
 

 
 

A Real -World 3D understanding of the axis is important when you are 
placing models in Google Earth 3 or casting realistic shadows.  

 

Moving the Global Axes  
 

You can quickly and accurately move and rotate the drawing axes relative 
to their current position using the Move Sketching Context dialog box. To 

move and rotate the drawing axes:  
 

1.  Context -click on the drawing axes. The drawing axes context menu 

is displayed.  

2.  Select Move  from the context menu.  The Move Sketching Context  

(Microsoft Windows) or Move Axes  (Apple macOS ) dialog box is 
displayed.  

 
The following image shows the Move Sketching Context  dialog box on 

Microsoft Windows:  
 

 
3 See this video for more  : https://help.sketchup.com/en/sketchup/viewing -your -model -

google -earth  

https://help.sketchup.com/en/sketchup/viewing-your-model-google-earth
https://help.sketchup.com/en/sketchup/viewing-your-model-google-earth
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The following image shows the Move Axes  dialog box on Apple macOS :  

 

 
 

3.  Specify displacement and rotation values in the units specified under 

the Units  panel of the Model Info  dialog box.  

4.  Click the OK  button.  

 

Aligning the point of view to the current view  
 

You can align SketchUp's point of view to be perfectly aligned with the 
current view. To align the point of view to the current view:  

 

1.  Context -click on the drawing axes. The drawing axes context menu 

is displayed.  

2.  Select Align View  from the context menu.  

 

Hiding the drawing axes  
 

You can display or hide the drawing axes from the View  menu . You can 
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also hide the drawing axes from the drawing axes Context menu  (when 

the drawing axes are visible).  
 

Context Menu 
 

Menu items also appear in special context menu: menus whose contents 
vary  depending on the context in which they are invoked (usually on one 

or more entities in the drawing area or on a user interface component, 
such as a dialog box).  

 

The following image shows a context menu for a Face entity.  
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

Context menus are invoked on entities by selecting one or more entities, 
holding down the Control key, and clicking the mouse button (single 

button mouse). Users with three -button or scroll -wheel mice can select 
one or more entities and click the right mou se button to invoke a context 

menu. This operation is referred to as a context -click .  
 

Context menus are invoked on user interface components, such as a 
dialog box, by clicking the right mouse button while the cursor is on the 

component (three button mouse) or holding down the Control key and 
clicking the mouse button (single button mouse).  
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Inference 
 
SketchUp features a geometric analysis engine, called the I nference 

Engine , allowing you to work in 3D space using a 2D screen and input 
device. This engine helps you draw very accurately by inferring points 

from other points as you draw while also providing you with visual cues.  
 

Encouraging an Inference  
 

At times, the inference you need may not come up immediately or 

SketchUp might choose alignments w ith the wrong geometry. In these 
cases, you can increase the chances of a particular alignment by pausing 

your mouse cursor over the particular location that you want SketchUp to 
infer from. When the visual cue appears, SketchUp will briefly prioritize 

tha t alignment as you continue drawing.  
 

To encourage SketchUp to create a parallel line to match the length of 
another, parallel, line (such as when drawing the third line of a rectangle):  

 

1.  Create the first two edges of a rectangle with the first edge being 

parallel to the red axes.  

2.  Click on the start point of the third edge and move the line tool as 

though you were creating the third line parallel to first line. As you 

begin to move the Line tool, the line should appear in red.  

 
 

 
 

 
 

 

3.  Mid- line creation, move the Line tool over the s tart point of the first 

line you created for the rectangle. Your line will extend diagonally to 

this point.  

4.  Leave the tool over this point until the Endpoint visual cue displays.  

 
 

 
 

 
 

5.  Move the Line tool to the approximate location where the end of the 

third line should appear. A dotted line, with the color of the 

corresponding axes (green) will follow the Line tool to indicate you 
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are directly inline with the start point of the first line.  

 

 
 

 
 

 
 

6.  Click when the line you are drawing is indicated by an axes color 

(red) and is directly perpendicular to the green dotted line.  

 
 

 
 

 
 

 

 

Note: Hover over any line to create a line parallel to that line. Refer to 

Inference Types  for further information.  

 

Locking an Inference  
 

At times, geometry might interfere with your ability to infer points from 
other points, making it difficult to draw a ccurately. Use an inference lock, 

which tells SketchUp not to waver from the direction it is currently 
inferring from, to solve this problem. To use the inference lock, press hold 

the Shift  key when SketchUp infers the desired alignment (the inference 
line  will bold). The alignment will remain locked, even as you move the 

mouse and/or pick a secondary inference point.  
 

The following image shows the  inference locked in the blue direction to 

ensure that a new line is exactly perpendicular to the face.  
 

 
 

Any of the inference conditions may be locked; along an axis direction, 
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along an edge direction, on a face, from a point, parallel or perpendicular 

to an edge, and so on.  
 

Forcing an Inference Direction  
 

You can force SketchUp to infer parallel to a specific axis by pressing one 
of the following keys while using the Line  tool, Move  tool, or Tape Measure  

tool:  

 

Å Right arrow key = red axis  

Å Left arrow key = green axis  

Å Up arrow key = blue axis  

 

Note: Down arr ow locks to what direction has been focused to . 
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Dialog Boxes 
 
Minimizing dialog boxes  

 
Click on any dialog box's title bar to minimize or maximize the dialog box 

(even those that can not be placed in a dialog box stack).  
 

Resizing dialog boxes  
 

Some SketchUp dialog boxes, such as the Components Browser  dialog 

box, can be resized. Move the cursor around the dialog box's edges to 
display a resize cursor (two arrows). Click on the edge and move the edge 

to resize the dialog box.  
 

Snapping dialog boxes to other user interface components  
 

Some dialog boxes, such as the Styles Browser  dialog box, automatically 
snap to the outside edges of the application window, the outer edge of the 

screen, with the top and bottom of other dialog boxes to cre ate a dialog 
stack. To snap a dialog box to another user interface component:  

 

1.  Display a dialog box, such as the Window > Styles  dialog box.  

2.  Click and hold on the dialog box's title bar.  

3.  Move the dialog box to the outside edge of the application window, 

outside edge of the screen, or top or bottom edge of another dialog 

box (such as the Shadow Settings  dialog box). The dialog box will 

snap to and align with the edge.  

 

Note: Dialog boxes that have been snapped to the application window do 

not move when th e application window is moved (they are not stuck to the 

window).  

 

Tip: Snap several dialog boxes together at their top and bottom edges to 

form a dialog box stack. Dialog boxes in a dialog box stack move with the 

stack when the top -most dialog box's title bar is moved.  
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Principal Tools 
 

Å Select Tool  

Å Make Component  Tool  

Å Paint Bucket Tool  

Å Eraser Tool  

 

Select Tool 
 

Select entities to modify when using other tools or commands.  
 

Tool Operation  
 

Click on an entity.  
 

Modifier Keys  

 

Å Ctrl = Add an entity to set of selected entities  

Å Shift+Ctrl = Subtract an entity from set of selected entities  

Å Shift = Toggle whether an entity is within set of selected entities  

Å Ctrl+A = Select all visible entities in model  

Select tool introduction  
 

Use the Select  tool to specify the entities you will modify when using other 
tools or commands. The entities that are included in a selection are 

referred to as the selection set . Activate the Select  tool from the Getting 
Started, Large Tool Set, and  Principal  toolbar s (Microsoft Windows), the 

Tool Palette  (Apple macOS ) or from the Tools  menu.  
 

Keyboard Shortcut: Spacebar  
 

Selecting multiple entities  

 
There are multiple ways to select multiple entities in SketchUp. These 

ways are:  
 

Å Selecting multiple  entities with a selection box.  

Å Selecting connected entities using rapid mouse clicking.  

Å Selecting connected entities using the Select context -menu item.  

Selecting multiple entities with a Selection box  

 
A selection box is an expandable temporary box used to select multiple 
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entities. Selection box selections are useful when you want to perform a 

single operation on several connected or disconnected entities (the 
selection set).  

 
To select multiple entitie s:  

 

1.  Choose the Select  tool. The cursor will change to an arrow.  

2.  Click and hold the mouse button a short distance away from the 

entities you want to select to start a selection box.  

3.  Drag the mouse to expand the selection box over the elements you 

want to select.  

Å Clicking to the right -side and dragging to the left, called a crossing 

selection , selects any elements within the selection rectangle, 

including those that are only partially contained in the rectangle.The 

following images show a right - to - left sel ection selecting two 

components, though none are completely within the bounds of the 

selection box.  

 
 

 
 

 

 
 

 
 

 
 

 

Å Clicking to the left -side of the entities and dragging right, called a 

window selection , selects only those elements completely within the 

selection rectangle. The following image shows a left - to - right 

selection selecting one component because only one com ponent (the 

left speaker) is completely within the bounds of the selection box.  
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4.  Release the mouse button when all of  the elements are either 

partially included (right - to - left selection) or fully included (left - to -

right selection) in the selection box.  

 

Selecting connected entities using rapid mouse clicking  
 

Rapidly clicking the mouse button will select one or more add itional 
connected entities.  

 

To Select a face and its bounding edges :  

 

1.  Choose the Select  tool. The cursor will change to an arrow.  

2.  Double -click on a face to select the face and all of its bounding 

edges. The selected entities are highlighted.  

 

To select just a face and an edge :  

 

1.  Choose the Select  tool. The cursor will change to an arrow.  

2.  Double -click on an edge to select the connected face. The selected 

entities are highlighted.  

 

To select all entities connected to a single entity :  

 

1.  Choose the Select  tool. The cursor will change to an arrow.  

2.  Triple -click rapidly on any entity, in a set of connected entities, to 

select all of the connected entities. For example, if you triple -click a 

face in a cube, the entire cube is selected. Selected entities are 

highlighted.  

 

Selecting connected entities using the Select context - menu item  
 

Use the Select  context -menu item to select entities based on their specific 
relationship to the currently selected entity. To use the Select context -

menu item:  

 

1.  Select the Select  tool ( ). The cursor will change to an arrow.  

2.  Context -click 4 on a single entity, suc h as an edge or face. The 

entity's context -menu appears.  

3.  Select the Select  menu item. A sub -menu appears.  

4.  Select one of the Select  sub -menu items:  

 
4 aka right -click .  
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Å Select Bounding Edges  if you want to select all the bounding 

edges of a selected face.  

Å Select Connected Faces  to select all of the faces connected 

to the selected entity.  

Å Select All Connected  to select all entities connected to the 

selected entity (this is identical to perfo rming a triple -click on 

the entity).  

Å Select All on same Layer  to select all the entities on the 

same layer as the selected entity.  

Å Select All with same Material  to select all the entities on 

with the same material as the selected entity.  

Å Select  Invert Selection  to deselect a selected element and 

select all elements in the model which were not selected.  

Adding and subtracting from a selection set  

 
The Select  tool can be used with one or more keyboard modifiers to add 

or remove entities from a selection set.  
 

Adding to the selection set  
 

Press and hold the Ctrl  (Microsoft Windows) or Option  (Apple macOS ) 

key (the cursor will change to an arrow with a plus sign ) while clicking on 
additional entities to add entities, one -by -one, to the selection set. Or, 

press and hold the Shift  key (the cursor will change to an arrow with a 
plus and minus signs) while clicking on additional entities to add entities, 

one -by -one, to the selection set.  
 

Changing selection status for an entity  
 

Press and hold the Shift  key (The cursor will change to an arrow with plus 
and minus signs) while clicking on entities to invert the selection status of 

the entity (currently selected entities  will become unselected, unselected 
entities will be come selected).  

 
Subtracting from the selection set  

 

Press and hold the Shift  and Ctrl  (Microsoft Windows) or Option  (Apple 
macOS )  keys simultaneously (the cursor will change to an arrow with a 

minus sign) while clicking on currently selected entities to remove entities 
from the selection set. Or, press and hold the Shift  key (the cursor will 

change to a plus sign and minus sign) whil e clicking on currently selected 
entities to remove the entities, one -by -one, from the selection set.  
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Tip: Use the Group entity to group items within a selection set as a 
temporary way of quickly reselecting the same group of items. See the 

Group entity f or additional information.  

 

Expanding the selection set using the mouse  
 

You can automatically add to a selection set by clicking the mouse button 
(while in the Select  tool) multiple times in rapid succession. Click once on 

an entity to select that entity . Click rapidly twice (double -click) on an 
entity, namely an edge or face, to select corresponding faces or edges 

respectively. Click three times (triple -click) on an entity, namely an edge 
or face, to select the edge or face and all entities physically co nnected to 

that edge or face. The following image shows this click/selection 
sequence.  

 

 
 

 
 

 
 

 

Tip: Use a context - click to invoke the context menu for an entity. Many 
context menus have a Select submenu allowing you to expand a selection 

using one of the following commands: Bounding Edges, Connected Faces, 

All Connected, All on same layer, and  All w ith same material .  

 

Selecting a single entity  

 
SketchUp allows you to make both single -entity and multiple -entity 

selections. To select a single entity:  
 

1.  Select the Select  tool ( ). The cursor changes to an arrow.  

2.  Click on an entity. The selected entity  is highlighted in yellow.  

 

Tip: To select or unselect all geometry, choose Edit > Deselect All , press 

Ctrl+T  (Microsoft Windows) or Shift+Command+A  (Apple macOS ). 
Alternatively, click on any empty space in the drawing area to de -select all 

currently selected entities.  
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Make Component 
 
Make a component from the selected entities.  

 
For more on Components read this 5. 

 
 

 

  

 
5 https://help.sketchup.com/en/working -components -sketchup  

https://help.sketchup.com/en/working-components-sketchup
https://help.sketchup.com/en/working-components-sketchup
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Paint Bucket Tool 
 
Assign materials and colors to entities.  

 
Tool Operation  

 

1.  Select a materials library using drop down list in Materials  Browser .  

2.  Select a material from Materials Library .  

3.  Click on faces to paint.  

 
Modifier Keys  

 

Å Shift = Paint all faces with matching materials  

Å Ctrl = Paint all connected faces with matching materials  

Å Shift+Ctrl = Paint all faces on the same object with matching 

materials  

Å Alt = Sample material for painting  

 

 Paint Bucket tool introduction  

 
Use the Paint Bucket tool to assign materials and colors to entities in 

your model. You can use it to paint individual entities, fill a number of 
connected faces, or replace a material with another throughout your 

model. Activate the Paint Bucket  tool from the Principal  toolba r 
(Microsoft Windows), the Tool  Palette  (Apple macOS ), or by choosing 

Paint Bucket  from the Tools  menu.  
 

The Paint Bucket  tool is separate from the Apple Color Picker  used to 
select colors and materials ( Apple macOS ).  

 
Keyboard Shortcut: B  

 

 Face paintin g rules  

 
There are several face painting rules that apply when painting multiple 

faces or edges at the same time. These rules follow:  
 

Å The side of the faces that will be painted depends on the side 

initially painted when more than one face is selected. For example, if 

all faces are selected and you paint the front of one face, the front 

of all faces will be painted. Conversely, if all fac es are selected and 

you paint the back of one face, all back faces will be painted.  

Å All selected edges will be painted when you select a face and all 

edges and paint the front of the face. No edges are painted when 
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you select a face and all edges and pain t the back of one face. In 

order to see the painted effect applied to edges, you'll need to 

display the edge color by material. To do so, open the Styles 

Browser  (under the Window menu), choose the Edit  tab, and select 

the Edge Settings  button. Finally, ch oose By material  from the 

Color menu.  

 Fill options  

 
The Paint Bucket  tool can be used with one or more keyboard modifiers 

to perform various painting operations.  
 

Element fill  
 

The Paint Bucket  tool normally operates by filling in faces as you click on 
them. As mentioned previously, entities selected with the Select  tool can 

be painted with a single click of the Paint Bucket  tool.  
 

Note: Selecting a number of entities with the Select tool and painting causes 

just the entities within the selection set to be painted.  

 

Adjacent fill  
 

Press and hold the Ctrl  (Microsoft Windows) or the Option  (Apple macOS ) 
key while clicking on a face with the Paint Bucket  tool to fill that face and 

any adjacent (connected) face with the same material. The face you click 
on and the adjacent face must have the same material prior to performing 

this operation.  
 

 
 

 
 

 
 

 

 
 

 

Note: Selecting a number of entities with the Select t ool and painting using 
the Ctrl (Microsoft Windows) or the Option ( Apple macOS ) modifier key 

causes just the entities within the selection set to be painted.  

 
Replace  

 
Press and hold the Shift key prior to clicking on a face with the Paint 
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Bucket  tool to a pply a material to every face, with the same material in 

the current context, with the new material.  
 

 
 

 
 

 

 
 

 
 

 

Note: Selecting a number of entities with the Select tool and painting using 
the Shift modifier key causes just the entities within the selection set to be 

painted.  

 
Adjacent replace  

 
Press and hold both the Shift  and the Ctrl  (Microsoft Windows) or the 

Option  (Apple macOS ) keys simultaneously while painting to only replace 
the material on the face within the confines of geometry that is physically 

connected to that face.  

 

 Sampling a material  

 
Press and hold the Alt  (Microsoft Windows) or Command  (Apple macOS ) 

key to change from the Paint Bucket  tool to a Sample  tool for sampling 
materials within your model. The cursor will change to an eye dropper. 

Click on the face whose material you want to sample. Release the Alt  

(Microsoft Windows) or Command  (Apple macOS ) key to return to the 
Paint Bucket  tool. Paint the sampled material on a face.  

 
 

 
 

 
 

 
 

 
 

Note: The sampled material is placed in the Active Color Well of the Color 

Picker, where it can be painted on new entities, modified, or used as the 

basis of a new material ( Apple macOS ).  
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 Painting groups and components  
 

Materials can be painted on entire Group entities or Component entities or 
to the individual entities within the group or component. To assign 

materials to an entire group or component:  
 

1.  Select the Paint Bucket  tool. The cursor will change to a paint 

bucket and the Material s Browser  is activated. The Materials 

Browser  contains libraries of materials you can paint on faces in 

your model.  

2.  Select a materials library using the drop down list box. SketchUp 

contains several default materials libraries, including landscape, 

roofing, and transparent materials.  

3.  Select a mater ial from the library of materials.  

4.  Click on the group or component you want to paint. The faces will 

receive the material.  

5.  If you select multiple groups or components using the Select  tool, 

clicking on the selection with the Paint  Bucket  tool will paint all of 

them with a single click.  

 

Note: If a face within a group or component is already painted with a 

material (other than the default material), before applying a material to the 
ent ire group or component, the face will not adopt the new material. For 

example, the windshields, bumpers, and tires in the following  image were 

already painted before a material was applied to these components. 
Therefore, the windshields, bumpers, and tires  maintained their original 

material.  

 
 

 
 

 
 

 
 

Note: Exploding a group or component assigns the object materials to any 

elements assigned the default material, thus making the material override 

permanent.  
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Eraser Tool 
 
Erase , soften or smooth entities in the model .  

 
 

Tool Operation  
 

Click on entity to erase. Alternatively, hold down mouse button and drag 
over entities. All entities are erased when mouse button is released.  

 

Modifier Keys  
 

Å Shift = Hide entities  

Å Ctrl = Soften and smooth entities  

Å Shift+Ctrl = Unsoften and unsmooth entities  

 

 Eraser tool introduction  

 

Use the Eraser  tool to delete entities. The Eraser  tool can also be used to 
hide and soften edges. Activate the Eraser  tool from the Principal  

tool bar  (Microsoft Windows), the Tool  Palette  (Apple macOS ), or by 
selecting Eraser  from the Tools menu.  

 
Keyboard Shortcut: E 

 

 Erasing entities  

 

As mentioned previously, the Eraser  tool is used to erase entities in the 
drawing area. Note, the Eraser  tool does not allow you to erase faces 

(faces are erased after their bounding edges are erased). To erase 
entities:  

 

1.  Select the Eraser  tool ( ). The cursor changes to an eraser with 

a small box.  

2.  Click on an entity to erase it. Alternatively, erase sever al entities at 

once by holding down the mouse button and dragging it over 

several entities to be erased. All selected geometry will be erased 

once you release the mouse button.  

 

If you accidentally select geometry you do not wish to delete, press the 
Esc  key to cancel the erase operation before it deletes your selection.  

 

Tip: Try erasing entities slowly if you continuously skip over entities you 

want to erase.  
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Tip: It is usually faster to erase a large number of entities by selecting the 

entities with th e Select tool and pressing the Delete key on your keyboard. 

You can also delete selected items by selecting Erase from the Edit menu.  

 

Hiding lines  
 

Press and hold the Shift  key and use the Eraser  tool to hide lines 

(instead of erasing lines).  
 

 Softening or unsoftening edges  
 

Press and hold the Ctrl  (Microsoft Windows) or Option  key ( Apple 
macOS ) key to soften/smooth edges (instead of erasing entities). Press 

and hold the Shift  and Ctrl  (Microsoft Windows) or Option  (Apple 

macOS ) keys simultaneously to unsoften/unsmooth edges.  
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Drawing Tools 
 

Å Line Tool  

Å Freehand Tool  

Å Rectangle Tool  

Å Rotated Re ctangle Tool  

Å Circle Tool  

Å Polygon Tool  

Å Arc Tool  

Å 2 Point Arc Tool  

Å 3 Point Arc Tool  

Å Pie Tool  

 

Line Tool 
 

Draw edges from point to point .  
 

Tool Operation  
 

1.  Click at starting point of line.  

2.  Move cursor.  

3.  Click at ending point of line.  

4.  (optional) Move cursor.  

5.  (optional) Click to create connected line.  

6.  (optional) Repeat step 4 to create connected lines, or return to 

starting point of first line to create a face.  

Modifier Keys  
 

Å Shift = Lock line to the cu rrent inference direction  

Å up arrow, left arrow, right arrow = Lock line to specific inference 

direction (up=blue, left=green, right=red)  

 Line tool introduction  

 
Use the Line  tool to draw edges or line entities. Line entities can be joined 

to form a face. The Line  tool can also be used to divide faces or heal 
deleted faces. Activate the Line  tool from the toolbar  / Tool Palette  or 

from the Draw  menu.  
 

Keyboard Shortcut: L 
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 Creating a face  
 

Face entities are flat plane - like entities that combine to form the 3D 
geometry in a SketchUp model. Faces are automatically created when any 

three or more intersecting lines or edges are in the same plane (an infinite 
flat 2D space), or coplanar. To creat e a face using the Pencil  tool:  

 

1.  Select the Line  tool ( ). The cursor changes to a pencil.  

2.  Click to set the starting point of your line.  

3.  Move the cursor to the ending point of your line. As you draw a line, 

the length is displayed dynamically in the Measurements  toolbar .  

4.  Click to draw your line. This ending point can also be the starting 

point of another line.  

 

 
 

5.  Move the cursor to an ending point for the second line.  

6.  Click to draw your line. This ending point can also be the starting 

point of another line.  

 

 
 

 
 

 
 

 
 

 
 

7.  Move the cursor to the starting point of the first line. The tip of the 

Pencil cursor changes t o a green circle and says "Endpoint."  
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8.  Click to draw your line. A face is created.  

 
Tip: Set the display settings ( View > Face Style > Shaded ) to the 

"Shaded" or "Shaded With Textures" rendering style to clearly show new 

faces as they are created.  

 

 Splitting a face  
 

Draw a line with starting and ending points on the face's edges to split a 

face. The following image shows a rectangle being split when a line is 
drawn from one edge of a face to another opposite edge.  

 
 

 
 

 
 

 
 

 Splitting a line  

 
SketchUp automatically splits line segments when new lines are drawn 

perpendicular to a line. For  example, draw a new line to the midpoint 
(identified by a cyan square) of another line to split a line in half. The 

following example shows one line being intersected at the midpoint, 
resulting in two lines.  

 
 

 
 

 

 
 

Select the original line to verify that the line has been split into two equal 
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segments.  

 
Dividing a line into equal segments  

 
Line segments can be divided into any number of  equal line segments. To 

divide a line into equal segments:  
 

1.  Context -click on a line.  

2.  Select Divide  from the context menu. SketchUp will place points on 

the line to show where the line will be divided.  

3.  Move the cursor toward the center of the line to reduce the number 

of segments. Move cursor toward either end of the line to increase 

the number of segments.  

4.  Click on the line when the number of segments you would like is 

shown. The line will be divided i nto an equal number of joined line 

segments.  

 

 Dividing a line into equal segments  
 

Line segments can be divided into any number of equal line segments. To 
divide a line into equal segments:  

 

1.  Context -click on a line.  

2.  Select Divide  from the context menu.  SketchUp will place points on 

the line to show where the line will be divided.  

3.  Move the cursor toward the center of the line to reduce the number 

of segments. Move cursor toward either end of the line to increase 

the number of segments.  

4.  Click on the lin e when the number of segments you would like is 

shown. The line will be divided into an equal number of joined line 

segments.  

 Creating precise lines  
 

The Measurements  toolbar  displays the length of your line while you are 
drawing lines. You can also specify a line length value using the 

Measurements toolbar . 
 

Entering a length value  
 

The Measurements toolbar  label indicates 'Length' after you place the 

starting point of a line. The following image shows the length value in the 
Measurements toolbar . 
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Type the length into the Measurements toolbar , after placing the starting 

point of the line, and press the En ter  (Microsoft Windows) or Return  
(Apple macOS ) key. SketchUp will use the current document units setting 

if you only type in a numerical value. You can also specify either Imperial 
(1'6") or Metric (3.652m) units at any time, regardless the model units 

setting.  
 

Note: The Line tool will snap to any previously entered length within the 

Measurements toolbar . 

 

Entering a 3D coordinate  
 

The Measurements toolbar  can also be used to place the end of the line at 
an exact  coordinate in space . 

 
 

 
Entering an Absol ute Coordinate30Type in the coordinates of a point in 3D 

space enclosed by brackets, such as [x, y, z], to get absolute coordinates 
relative to the current axes.  

 
 

 

Entering a Relative Coordinate  
 

Type the coordinate points enclosed by angle brackets, in the format , 
where x, y, and z values are relative distances from the starting point of 

your line.  
 

Note: The exact format for Measurements toolbar  entries will vary 

depending on your computer's Regional Settings. For European users, the 
list separator symbol may be a semi -colon instead of a comma, so the 

format would be [x;y;z].  

 

 Drawing lines by inference  
 

The Line tool uses SketchUp's sophisticated geometric inference engine to 
help you place your lines in 3D space. The inference decisions , made by 

the inference engine, are displayed in the drawing area as inference lines 
and inference points. These lines and points show precise alignment 

between the line you are drawing and the geometry of your model. Refer 
to the inference engine topic fo r additional information.  

 
Locking a line to the current inference direction  

 

Press and hold the Shift  key, while the line you are drawing is the specific 
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color of an axis, to lock drawing operation to that axis.  

 
Locking a line to a specific inference direction  

 
Press and hold either the up arrow, left arrow, or right arrow keys, where 

the up arrow equals blue, left arrow equals green, right arrow equals red, 
while drawing a line to lock the line to a specific axis.  
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Freehand Tool 
 
Draw fre ehand lines by clicking and dragging .  

 
Tool Operation  

 

1.  Click and hold at starting point of curve.  

2.  Drag the cursor to draw.  

3.  Release mouse button to stop.  

4.  (optional) End curve at starting point to draw closed shape.  

5.  Esc = Cancel operation.  

 

Modifier Keys  
 

Shift = Draw 3D Polyline entity  
 

 Freehand tool introduction  

 

Use the Freehand tool to draw irregular hand -drawn lines in the form of 
Curve entities and  3D Polyline entities. Curve entities are comprised of 

multiple line segments that are connected together. These curves behave 
as a single line in that they can define and divide faces. They are also 

connected such that selecting one segment selects the en tire entity. Curve 

entities can be useful for representing contours in a contour map or other 
organic shapes. Activate the Freehand tool from the toolbar  / Tool Palette 

or from the Draw menu.  
 

 Drawing 3D polyline entities  
 

3D polylines do not generate in ference snaps or affect geometry in any 
way. 3D polylines are usually used for tracing imported drawings, 2D 

sketching, or for decorating your model. Press and hold the Shift key, 

before you begin drawing, to draw a 3D polyline.  
 

Note: Select Explode from the 3D polyline's context menu to convert a 

Freehand Sketch into regular edge geometry.  
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Rectangle Tool 
 
Draw rectangular faces from corner to corner . 

 
Tool Operation  

 
1.  Click to set first corner.  

2.  Move cursor diagonally.  
3.  Click to set second corner.  

4.  Esc = Cancel Operation.  

 
Modifier Keys  

 
Shift = Lock rectangle to current inference direction  

 

 Rectangle tool introduction  

 
Use the Rectangle tool to draw rectangular Face entities, specified by 

clicking at two opposite corners of the desired shape. Activate the 

Rectangle tool from the toolbar  / Tool Palette or from the Draw menu.  
 

 Drawing a square  
 

Squares are created with t he rectangle tool in conjunction with the Square 
tool tip. To draw a Square:  

 

1.  Select the Rectangle  tool ( ). The cursor changes to a pencil 
with a rectangle.  

2.  Click to set the first corner point of the rectangle.  

3.  Move your mouse to the opposite corner. A diagonal dotted line will 
appear, along with a Square tool tip, when you are in a position that 

will create a square.  

Note: Press the Esc  key at any point during the operation to start over.  

 

4.  Click to finish.  
 

Tip: A dotted line and Golden Section tool tip appears when you are in a 

position to create a Golden Section.  Alternately, you can press your mouse 

button on the first corner of your rectangle, drag to the opposite corner, 

and release the mouse button.  

 

Tip: Use the Axes tool to re -align the axes, prior to drawing your rectangle, 

if you want to draw a rectangle that is not aligned with the default drawing 

axes orientation.  
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 Creating p recise rectangles  
 

A rectangle's dimensions dynamically appear in the Measurements toolbar  
as you draw. Specify exact length and width dimensions by typing them in 

the Measurements toolbar , and pressing Enter  (Microsoft Windows) or 
Return  (Apple macOS ) eit her after the first corner is clicked or 

immediately after the rectangle is drawn.  
 

 
SketchUp will use the current document units setting if you only type in a 

numerical value. You can also specify either Imperial (such as 1'6") or 
Metric (such as 3.652m) units at any time, regardless the document units 

setting.  
 

You can also type one dimension at a time in the Measurements toolbar . If 

you enter a value and a comma (3',), the new value will be applied to the 
first dimension, and the second dimension  will be retained from before. 

Similarly, if you type a comma and then a value (,3'), only the second 
dimension will be changed.  

 

Note: if you're using a non -English keyboard, you'll want to use a comma 
to indicate the decimal place and a semi -colon to sep arate the dimensions. 

For example, you might enter two sides of a rectangle as: 7,6m;4,3m . 

 

Tip: If you enter a negative value ( -24, -24), SketchUp will apply that value 
in a direction opposite to the one you indicated while drawing and accept 

any new values in the new direction.  

 

 Drawing rectangles by inference  
 

The Rectangle tool uses SketchUp's geometric inference engine to help 
you place your rectangles in 3D space. The inference decisions, made by 

the inference engine, are displayed in the drawin g area as inference lines 
and inference points. These lines and points show precise alignment 

between the rectangle you are drawing and the geometry of your model. 
For example, if you move your mouse over an endpoint of an existing 

edge and then move away in the direction of an axis, a dotted inference 
line with a From Point tool tip will appear.  
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This tool tip indicates that you are aligned to that end point. You can also 

use a From Point inference to draw rectangles vertically or at non -
orthogonal  planes.  
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Rotated Rectangle Tool 
 
Draw rectangular faces from three corners . 

 
Tool Operation  

 

1.  Click to set first corner.  

2.  Move your cursor around the protractor to set the direction of the 

first edge.  

3.  Click to set second corner.  

4.  Move your cursor to set the length and angle of the second edge.  

5.  Click to set third and final corner.  

6.  Esc = Cancel Operation.  

 

Modifier Keys  

 

Å Shift = Lock rectangle to current inference direction or protractor 

baseline  

Å Alt (after first click) = Lock drawing plane for first edge  

Å Alt (on a locked plane, after first click) = Set protractor baseline  

Å Alt (after second click) = Set protractor baselin e  

 
The Rotated Rectangle Tool  can come in handy when you need to draw a 

rectangle that doesnôt line up with the default red, green, or blue axes in 
SketchUp. Like the Rectangle Tool , you can create precise rectangles, 

squares, and also utilize inferencing. In this article, weôll cover the process 
of creating a rotated rectangle and creating a precise rotated rectangle.  

 

Tip: You should be familiar with SketchUpôs Rectangle Tool before working 

with the Rotated Rectangle tool.  

 

Creating a rotated rectangle  
 

1.  Click the black arrow in the Shape Tools  option in the toolbar. This 

will open the Shape Tools menu. Select the Rotated Rectangle tool    

( ). Alternatively, you can click Draw > Shapes > Rotated 

Rectangle .  

2.  Select the Rotated Rectangle  option.  

3.  Click once to set the first corner of your rectangle.  

4.  Move your cursor around the protractor to set the direction of the 

first edge.  

5.  Click to set second corner.  

6.  Move your cursor to set the length and angle of the second edge. 
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Experiment with this behavi or a bit to get the hang of it. You can 

always Undo and try again.  

7.  Click to set third and final corner.  

 

Creating a precise rotated rectangle  

 

1.  Drawing the first edge : After you click once to set  the first corner of 

a rotated rectangle, move your mouse cursor around the screen. 

You will see the corner stay in place and an edge will remain 

attached to your mouse cursor. You can also click and drag the first 

click to set the baseline. See ñSetting the baselineò below for more 

information. Note that you hav e precise control over the length and 

the direction of the first edge.  

 

 
 

 
 

 

a.  Inferencing : Move your mouse cursor so that the first edge 

parallels one of the  default axes directions: red, green, or 

blue; the edge will turn red, green, or blue. Press and hold the 

Shift  key and the edge will turn thicker. The edge will now 

only draw along that default axes direction. Alternatively, you 

can also press the Right  Arrow key to lock the edge to the 

red axes, the  Left Arrow key to lock the green  axes, and the 

Up Arrow  key to lock the blue axes. Other standard 

inferences , such as parallel or perpendicular edges, are also 

accessible when drawing the first edge.  

b.  Setting the baseline : Pressing the  Alt  key (Microsoft Windows) 

or the  Command  key  (Apple macOS ) initially does two things: 

lock the drawing plane and create a baseline that shows the 

direction of the first edge at the time you lock the baseline. If 

you keep  the first edge on the baseline, you can press and 

hold the Shift  key to lock the edge to the baseline. Press the 

Alt  key (Microsoft Windows) or the Command  key ( Apple 

macOS ) to reset the baseline. This is especially helpful if you 

need to lock the first e dge to a specific direction.  

c.  Setting the angle or length :  Before  you click a second time to 

complete the edge, you  can type the exact angle, length, or 

both in the Measurements toolbar  and press Enter (Microsoft 

Windows) or  Return (Apple macOS ).   
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Note: Typing the Angle is only available after you set the baseline -  

initially you can only define the length.  

 

For example to set the angle to 45 degrees, type ñ45,  ñ. Notice the 
empty value after the comma.  

 

Note: If you type the angle in the Measurements too lbar , this will lock 

the direction of the rectangle. Tap the Shift key to unlock.  

 
Likewise, to set the distance to ten feet, type ,10' . Again, notice the 

empty value before the comma. Finally, to set the angle and the 
length, enter the degrees first, then  a comma, then the length of the 

edge. For example, 45,10'  would create a 45 degree angle that is ten 
feet long.  

 

2.  Drawing the second edge : After you set the length and direction of 

the first edge of a  rotated rectangle, you can draw a second edge 

which wil l draw the completed rectangle.  

3.  Setting the angle or width : Move your mouse around after you set 

the first edge.  The outline of a rectangle will be connected to your 

mouse cursor with additional guides that indicate the drawing plane 

and angle. Look at th e Measurements toolbar , and you will notice 

both an angle and a distance. To set a precise angle and distance, 

type the angle followed by a comma then type the length of the 

second edge. For example, typing 90, 5'  will draw a rectangle that is 

perpendicula r to the plane of the first edge and five feet long. Press 

Enter  (Microsoft Windows) or Return (Apple macOS ). Just like 

when you set the first edge, you can type just the angle  or the width 

with empty values before/after the comma.  

 

Note: If you type the angle in the Measurements toolbar , this will lock the 

direction of the  rectangle. Tap the Shift key to unlock.  

 

Å Setting the baseline : Just like when you draw the first edge, you can 

reset the  baseline by pressing the Alt  key (Microsoft Windows) or 

Command  key ( Apple macOS ).  

Å Inferencing : Just like drawing the first edge, you can move your 

mouse cursor so  that the second edge parallels one of the default 

axes directions: red, green, or blue; the edge will turn red, green, or 

blue. Press and hold the Shift  key and the edge will turn thicker. 

The edge will now only draw along that default axes direction. 

Alternatively, you can also press the Right Arrow  key to lock the 

edge to the red axes, the Left Arrow  key to lock the gree n axes, 

and the Up Arrow  key to lock the blue axes. Other standard 

inferences , such as parallel or perpendicular edges, are also 
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accessible when drawing the second edge.  

 

Note: Both the Square and Golden Section inferences are also available to 

rotated re ctangles.  

 

Note: if you're using a non -English keyboard, you'll want to use a comma 
to indicate the decimal place and a semi -colon to separate the values in 

Measurements toolbar . For example, you might enter the angle and length 
of the second edge as 43,2; 8,2m  to get an angle thatôs 43,2 degrees and 

8,2 meters long.  
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Circle Tool 
 
Draw circle s from center point to radius . 

 
Tool Operation  

 

1.  Click to place center point.  

2.  Move cursor away from center point to define radius.  

3.  Click to finish circle.  

4.  Esc = Cancel operation.  

 

Modifier Keys  
 

Shift (before first click) = Lock circle to current orientation  
 

 Circle tool introduction  

 
Use the Circle tool to draw Circle entities. Activate the Circle tool from the 

toolbar  / Tool Palette or from the Draw menu.  
 

Keyboard Shortcut: C 
 

 Locking a circle to its current orientation  

 
Press and hold the Shift  key, before you begin drawing a circ le, to lock 

drawing operation to that orientation.  
 

 Creating Precise Circles  

 
The Measurements toolbar  displays the radius after setting the center 

point of a circle. Use the Measurements toolbar  to enter an exact radius 
and number of segments.  

 
Specifyi ng a Radius  

 
The Measurements toolbar 's label indicates "Radius" after you place the 

center point of the circle. Type the radius size in the Measurements 
toolbar , after placing the center point, and press the Enter  (Apple 

macOS ) or Return  (Apple macOS ) key. You can perform this action either 
during or immediately following the creation of the circle. For example: 

24r  or 3'6"r  or 5mr . 
 

Note: The Circle Tool will snap to any previously entered radius within the 

Measurements toolbar . 

 



SketchUp User Manual ï version 19.   51 /211  

 

  
Specifying the Number of Sides  

 
The Measurements toolbar 's label indicates "Sides" when the Circle Tool is 

initially activated. Specify the number of sides i n the Measurements 
toolbar , and press the Enter  (Microsoft Windows) or Return  (Apple 

macOS ) key, before clicking to set the center point of the circle. For 
example: 100 . 

 

You can also specify the number of sides in a circle immediately after the 
creation o f the circle. Type the number of sides in the Measurements 

toolbar , followed by the letter s, and press the38 Enter (Microsoft 
Windows) or  Return (Apple macOS ) key. For example:  20s . This number 

will be  applied to any future circles.  
 

Note: The default number of segments for a circle is 24.  
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Polygon Tool 
 
Draw N-sided p olygon s from center point to radius . 

 
Tool Operation  

 

1.  Click to place center point.  

2.  Move cursor away from center point to define radius.  

3.  Click to finish polygon.  

4.  Esc = Cancel operation.  

 

Modifier Keys  
 

Å Shift (before first click) = Lock polygon to its current orientation  

Å Ctrl (before second click) = Toggle between inscribed and 

circums cribed radii of polygon  

 

 Polygon tool introduction  

 
Use the Polygon tool to draw regular Polygon entities. Activate the 

Polygon tool from the toolbar  / Tool Palette or from the Draw menu.  
 

 Locking a polygon to its current orientation  
 

Press and hold t he Shift key, before you begin drawing a polygon, to lock 

drawing operation to that orientation.  
 

 Drawing precise polygons  
 

The Measurements toolbar  displays the radius after setting the center 
point of a polygon. Use the Measurements toolbar  to enter an  exact radius 

and number of segments.  

 
Specifying a Radius  

 
The Measurements toolbar 's label indicates 'Radius' after you place the 

center point of the polygon. Type the radius size in the Measurements 
toolbar , after placing the center point, and press the Enter  (Microsoft 

Windows) or Return  (Apple macOS ) key. You can perform this action 
either during or immediately following the creation of the polygon. For 

example: 24r  or 3'6"r  or 5mr . 
 

Tip: Tap the Ctrl  key (Microsoft Windows) or Option  key ( Apple macOS ) 

to toggle between an inscribed or  circumscribed polygon.  
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Note: The Polygon tool will snap to any previously entered radius within 

the Measurements toolbar . 

 

Specifying the Number of Sides  
 

The Measurements toolbar 's label indicates 'Sides' when the Polygon tool 
is initially activated. Specify the numbe r of sides in the Measurements 

toolbar , and press the Enter  (Microsoft Windows) or Return  (Apple 

macOS ) key, before clicking to set the center point of the polygon. For 
example: 10 . 

 
You can also specify the number of sides in a polygon immediately after 

the creation of the polygon. Type the number of sides in the 
Measurements toolbar , followed by the letter s, and press the Enter  

(Microsoft Windows) or Return  (Apple macOS ) key. For ex ample: 6s. This 
number will be applied to any future polygons.  
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Arc Tool 
 
Draw arcs from center and two points . 

 
Tool Operation  

 

1.  Click to define arc center.  

2.  Move cursor to define first arc point or enter radius.  

3.  Click to set first arc point.  

4.  Move cursor around the protractor guide or enter angle.  

5.  Click to set second arc point.  

6.  Esc = Cancel operation.  

7.  Tip: Click Window > Model Info > Units > Angle Units to  change 

snapping angle.  

 
Modifier Keys  

 

Å Shift (before first click) = Lock arc to current orientation  

Å Shift (after first click) = Lock tool to current inference direction  

 

 Arc tools introduction  

 
Use the Arc tools to draw Arc entities: arcs comprised o f multiple 

connected line segments (which can be edited as a single arc). Activate 
any of the Arc tools from the toolbar  / Tool Palette or from the Draw 

menu. There are four Arc Tools; Arc, 2 -Point Arc, 3 -Point Arc, and Pie  
tools which all draw arcs but in different ways.  

 

Keyboard Shortcut for 2 -Point Arc: A 
 

 Drawing a half - circle using the 2 - Point Arc or  
    3 - Point Arc tools  

 
A 2 -Point arc temporarily snaps to a half -circle as you pull out a bulge 

distance. Similarly, when drawing a 3 -Point arc, the arc will snap to a half 

circle  before setting your third  point. Watch for the half -circle inference 
tool tip indicating when your arc is a half -circle.  

 

Drawing an open half - circle using the Arc tool  

 
Open half - circle entities consist of three parts: the center, the starting 

point and the ending point. To draw an open arc:  
 

1.  Select the Arc tool (icon). The cursor changes to a pencil with an 
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open arc and a half - circle protractor is drawn to show the 

orientation of a drawing plane.  

2.  Click to place the center of your arc. You have locked the orientation 

of the drawing plane and a full -circle protractor is drawn.  

3.  Move the cursor to the starting point of your arc.  

4.  Click to place the starting point of your arc. A straight dotted line is 

created which represents the radius of your arc.  

5.  Move the cursor to the ending point of your arc, for a half - circle use 

the inference locking to stop at 180 degre es.  

6.  Click to place the ending point of your arc. An open half -circle is 

created.  

 

Note: Press the ESC key at any point during the operation to start over.  

 

Drawing a closed half - circle using the Pie tool  

 

Closed half - circle entities consist of five parts : the center, the starting 
point and the ending point and two  edges (from center to starting and 

ending points).  
 

To draw a closed arc:  
 

1.  Select the Pie tool ( ). The cursor changes to a pencil with a 

closed arc and a half -circle protractor is drawn to sho w the 

orientation of a drawing plane.  

2.  Click to place the center of your arc. You have locked the orientation 

of the drawing plane and a full -circle protractor is drawn.  

3.  Move the cursor to the starting point of your arc.  

4.  Click to place the starting point of your arc. A straight solid line is 

created (you just established a radius for your arc and created the 

first edge of the pie).  

5.  Move the cursor to the ending point of your arc, for a half - circle use 

the inference locking to stop at 180 degrees.  

6.  Click to place the ending point of your arc. An closed arc is created 

with two edges.  

 

Note: Press the ESC key at any point during the operation to start over.  

 
The arc Radius value can be specified using the Measurements toolbar  

after you place the center point of your arc. Angle and number of 
segments can be specified using the Measurements toolbar  immediately 

after an arc is drawn. See Creating Precise Arcs  for more information on 

manipulating arcs using the Measurements toolba r. When you draw an 
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arc, by default, the arc will be drawn with a fixed number of line segments 

that will grow or shrink in length depending on the completeness of the 
arc. You can change the number of segments in the arc by typing a new 

value for "Sides:"  in the Measurements toolbar . For example, typing 10s 
will create an arc with 10 line segments.  

 
Arc tools allow you to set the number of Circle Sides  as well, which tells 

SketchUp how many line segments you'd like to see if you draw a full 

circle. When yo u specify the circle sides, the line segments stay roughly 
the same length and the number of line segments depends on the 

completeness of your arc.   
 

The following image shows a 1/4 Arc (Red), 1/2 Arc (Green), 3/4 Arc 
(Blue), and a Full Circle (Black). The  top shape was created using the Pie 

tool and set to have six Circle Sides.  
 

 
 

To specify the number of Circle Sides:  
 

1.  Select the Arc tool.  

2.  Without clicking anywhere else, type the number of Circle Sides in 

the Measurements toolbar , followed by the lette r "c". For example: 

20c  

3.  Press the Enter  (Microsoft Windows) or Return  (Apple macOS ) key.  

 
If you want to return to drawing a set number of line segments (vs Circle 

Sides), type the number of sides in the Measurements toolbar  followed by 
the letter "s". For example: 20s  

 

Note that you can also perform this action either during or immediately 

fo llowing the creation of the arc.  
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Creating precise arcs  
 

Use the Measurements toolbar  to enter exact lengths for the chord length, 
bulge distance, radius, number of segments, or angle.  

 

Note: SketchUp will use the current file units setting if you only typ e in a 
numerical value. You can also specify either Imperial (1'6") or Metric 

(3.652m) units at any time, regardless the file's units setting. Units are set 

within the Units panel of the Model Info dialog box.  

 

Entering a chord length  
 

For 2 -Point Arc tool : The Measurements toolbar 's label indicates 'Length' 
after you place the  starting point of an arc. Type the chord length into the 

Measurements toolbar , after placing the starting point of the arc, and 

press the Enter  (Microsoft Windows) or Return  (Apple macOS ) key. 
Specify a negative value, such as -6.5" , to indicate that you want the 

length to apply in an opposite direction to the current drawing direction.  
 

For the 3 -Point Arc tool : Typing a Length value in the Measurements 
toolbar  specifies the  linear length between the first point and the second 

point.  
 

Specifying a bulge distance  
 

For 2 -Point Arc tool : The Measurements toolbar 's label indicates 'Bulge' 
after you place the  ending point of an arc. Type the bulge length in the 

Measurements toolbar , after  placing an ending point, and press the Enter  
(Microsoft Windows) or Return  (Apple macOS ) key. You can also enter 

the bulge distance after the creation of the arc as long as 'Bulge' is 

displayed as the Measurements toolbar  label. Negative bulge values can 
also be used to create an arc in an opposite direction to the current 

drawing direction.  
 

After drawing the arc, select the Move tool, then click and drag the mid -
point of the arc to adjust the Bulge. You can type a specific value in the 

Measurements toolb ar . 
 

Specifying a radius  
 

For 2 -Point Arc: You can specify an arc radius instead of a bulge distance. 
Type the desired  radius in the Measurements toolbar , followed by the 

letter r  and press the Enter  (Microsoft Windows) or Return  (Apple 
macOS ) Key. You can perform this action either during or immediately 

following the creation of the arc. For example: 24r  or 3'6"r  or 5mr . 

44 For Arc and Pie tools: You can specify an arc radius in the 
Measurements toolbar  after your first  click. You don't need t o include the 
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letter r . 

 
After drawing the arc, select the arc, then context click on the arc and 

select Entity Info.  You can adjust the Radius field in Entity Info as 
needed.  

 
Specifying the number of segments  

 

You can also specify the number of segments in an arc. Type the number 
of segments in the Measurements toolbar , followed by the letter s, and 

press the Enter  (Microsoft Windows) or Return (Apple macOS ) key. You 
can perform this action either during or immediately following the  creation 

of the arc. F or example: 20s . 
 

Specifying the dynamic number of segments  
 

You can also specify the dynamic number of segments  (Circle Side s) in an 
arc. When specifying the dynamic number of segments, the number of 

segments in an arc will be proportionate to the arc central angle. Type the 
number of segments in the Measurements toolbar , followed by the letter 

c, and press the Enter (Microsoft Windows) or Return ( Apple macOS ) key. 
You can perform this action either during or immediately following the 

creation of the arc. For example: 20c With this setting a 90 degree arc will 

have 5 (20 * 90/360) segments.  
 

Specifying an angle  (for 3 -Point Arc, Arc, and Pie tools only)  
 

The Measurements toolbar 's label indicates 'Angle' after your second click 
when drawing the arc. Type the angle value (in degrees) in the 

Measurements toolbar  after placing a starting point, and press the Enter  
(Microsoft Windows)  or Return  (Apple macOS ) key. You can also enter 

the angle value after the creation of the arc as long as 'Angle' is displayed 
as the Measurements toolbar  label. Negative angle values can also be 

used to create an arc in an opposite direction to the curren t drawing 
direction.  

Specifying the axis of rotation  (for Arc and Pie tools only)  
 

Just like the Rotate and Protractor tool, you can click and drag the first 

point to define the axis of rotation. This is especially helpful if you need to 
rotate on an axis that isn't on the red, green, or blue planes.  

 

  

http://help.sketchup.com/en/article/3000036
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2-Point Arc Tool  
 

Draw arcs from point to point with bulge . 
 

Tool Operation  
 

1.  Click to set start point of arc.  

2.  Move cursor.  

3.  Click at ending point of arc or enter value.  

4.  Move cursor perpendicular to line to set bulge distance or enter value.  

5.  Click to finish arc.  

6.  Esc = Cancel operation.  

 
Modifier Keys  

 

Shift = Lock tool to current inference direction  
 

 Drawing tangent arcs and fillets  
 

The 2 -Point Arc tool and 3 -Point Arc tool will display a cyan tangent arc 
when you set your first point on an unconnected endpoint or on an edge. 

If you trace the second point of the arc along another edge, the arc will 
turn magenta when it is tangent to both edges. Double -click to finish the 

arc and create a fillet.  

 

Tip 1: After creating your first fillet, you can double -click at a point on 
another face near the corner of two edges. An arc/fillet of the last used 

radius will be drawn on the face at that corner.  

 
 

 
 

 
 

 
 

 
 

 

 
 

Tip 2: Similar to Tip 1, after creating your first fillet, you can double -click 

at a point on a 2D free -standing face (i.e. a face with only two connected 
edges) near the corner of two edges; the geometry outside the arc will be 

removed and make a rounded corner on the face. This also works on the 
very first fillet, too, by double -clicking the second endpoint after you see 
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the  magenta arc. To prevent SketchUp from removing the geometry, press 

the Alt key (Microsoft Windows) or the Command key ( Apple macOS ) when 

you double -click on the face.  
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3-Point Arc Tool   

 

Draw  arcs through three points on the arc circumference . 
 

Tool Operation  
 

1.  Click to set start point of arc.  

2.  Move cursor away from start point.  

3.  Click to set second point. The arc will always go through this point.  

4.  Move cursor to the end point. An angle will appear in the 

Measurements box, and you can type a precise value.  

5.  Click to finish arc.  

6.  Esc = Cancel operation.  

 
Modifier Keys  

 
Shift = Lock tool to current inference direction for any point.  
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Pie Tool 
 
Draw closed arcs from center and two points . 

 
Tool Operation  

 

1.  Click to define pie's center.  

2.  Move cursor to define first arc point or enter radius.  

3.  Click to set first arc point.  

4.  Move cursor around the protractor guide or enter angle.  

5.  Click to set second arc point.  

6.  Esc = Cancel operation.  

7.  Tip: Click Window > Model Info > Units > Angle Units to change 

snapping angle.  

 

Modifier Keys  
 

Å Shift (before first click) = Lock pie to current orientation  

Å Shift (after first click) = Lock tool to current inference direction  
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Modification Tools 
 

Å Move  Tool  

Å Push/Pull Tool  

Å Rotate Tool  

Å Scale Tool  

Å Offset Tool  

Å Follow Me Tool  

Å Intersect With Model Tool  

Å Position Texture Tool  

 

 

Move Tool 
 
Move, stretch, or copy entities.  

 
Tool Operation  

 

1.  Click on entity. Alternatively, pre -select multiple entities with Select 

tool.  

2.  Move cursor to new location.  

3.  Click to finish move operation.  

 

Modifier Keys  
 

Å Shift = Lock move to the current inference direction  

Å Ctrl = Toggles copy of selection  

Å Alt = Toggles auto fold  of selection  

Å up arrow, left arrow, right arrow = Lock line to specific inference 

direction (up=blue, left=green, right=red)  

 

 Move tool intro duction  

 
Use the Move tool to move, stretch and copy geometry. This tool can also 

be used to rotate components and groups. Activate the Move tool using 
the Modification toolbar  (Microsoft Windows), the tool Palette ( Apple 

macOS )or the Tools menu.  
 

Keyboard  Shortcut: M  
 

 Moving by inference  

 
The Move tool uses SketchUp's sophisticated geometric inference engine 
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to help you place entities in 3D space. The inference decisions, made by 

the inference engine, are displayed in the drawing area as inference lines  
and inference points. These lines and points show precise alignment 

between the move operation and the geometry of your model. Refer to 
the inference engine topic for additional information.  

 
Locking a move to the current inference direction  

 

Press and hold the Shift  key, while the move you are performing is the 
specific color of an axis, to lock move operation to that axis.  

 
Locking a line to a specific inference direction  

 
Press and hold either the up arrow, left arrow, or right arrow keys, w here 

up arrow equals blue, left arrow equals green, and right arrow equals red, 
while moving to lock the move to a specific axis.  

 

 Stretching geometry  
 

When you move an element that is interconnected with others, SketchUp 
will stretch geometry as necessa ry. You can move points, edges, and 

faces in this manner. For example, the following Face entity can be moved 
back in the negative red direction or up in the positive blue direction:  

 
 

 
 

 
 

 

 
 

You can also move single line segments to stretch an object. In  the 
following example, a line is selected and moved up in the blue direction to 

form a sloped roof.  
 

 
 

 
 

 
 

 

 Moving or stretching with Autofold  
 

SketchUp will Autofold faces automatically when a move or stretch  



SketchUp User Manual ï version 19.   65 /211  

 

  
operation will create non -planar faces. For example, clicking on the corner 

of a box with the Move tool and move down in the blue direction causes 
SketchUp to create a fold line along the box's top face.  

 
 

 
 

 

 
 

 
Forcing Autofold Behavior  

 
There are times when SketchUp constrains an opera tion in favor of 

keeping all faces planar and not creating additional fold lines. For 
example, clicking on the edge of a box with the Move tool only allows you 

to move the edge in a horizontal direction (red and green), but not 
vertically (blue).  

 
You can override this behavior by pressing and releasing the Alt (Microsoft 

Windows) or Command ( Apple macOS ) key before performing the move 
operation. This key sequence enables Autofold allowing geometry to move 

freely in any direction.  

 
 

 
 

 
 

 
 

 Making copies  

 
As mentioned previously, the Move tool can be used to make copies of 

entities within your model. To make copies of an entity using the move 
tool:  

 

1.  Select the Select  tool ( ). The cursor will change to an arrow.  

2.  Select the entities to be copied.  

3.  Select the Move  tool ( ). The cursor will change to a four -way 

arrow.  

4.  Press and release the Ctrl  (Microsoft Windows) or Option  (Apple 

macOS ) key on your keyboard. The cursor will change to a four -way 

arrow with a plus s ign. This action informs Sketchup that you want 

to duplicate the selected entities.  
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5.  Click on the selected entities to copy.  

6.  Move the cursor to copy the entities. A copy of the selected entities 

will follow as you move your mouse.  

7.  Click at the destinatio n point to finish your copy operation. The 

copied entities are now selected and the original entities are 

deselected.  

 

Note: You can press and release the Command  (Microsoft Windows) or 

Option  (Apple macOS ) key on your keyboard at any time during a move  

operation to perform a copy (not just at the start).  

 

 Creating multiple copies  (linear arrays)  

 
The Move tool can also be used to create arrays, or a series of copies of 

geometry. To create multiple copies of one or more entities:  
 

1.  Select the Select  tool ( ). The cursor will change to an arrow.  

2.  Select the entities to be copied.  

3.  Select the Move  tool ( ). The cursor will change to a four -way 

arrow.  

4.  Press and release the Ctrl  (Microsoft Windows) or Option  (Apple 

macOS ) key on your keyboard. The cur sor will change to an arrow 

with a plus sign. This action informs SketchUp that you want to 

duplicate the selected entities.  

5.  Click on the selected entities to copy.  

6.  Move your mouse to copy the entities. A copy of the selected 

entities will follow as you move your mouse.  

7.  Click at the destination point to finish your copy operation. The 

copied entities are now selected and the original entities are 

deselected.  

8.  Type a multiplier value to create additional multiple copies. For 

example, typing in 2x  (or *2 ) will create one additional copy (or 2 

copies total, the one you manually copied plus one you 

automatically copied using this step) instead of just one.  

Creating Copies at an Equal Distance Apart  
 

You can divide the distance between the copy and the orig inal by typing in 
a divisor value. For example, typing 5/  (or /5 ) will create five copies 

evenly distributed between the original and the first copy.  

 
You can keep typing in distances and multipliers until you perform another 

operation.  
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This fea ture is particularly useful in creating models of items such as 
fences, bridges, and decks, where you might want several posts or beams 

an equal distance apart.  
 

 Moving precisely  
 

The Measurements toolbar  at the bottom right corner of the SketchUp 

window displays the length of the move operation (displacement) in the 
default units, as specified under the Units panel of the Model Info dialog 

box, while moving, copying, or stretching entities.  
 

In addition to creating arrays, you can also specify an exact displacement 
or a relative or absolute 3D coordinate for the finishing point during, or 

immediately after, a move operation.  
 

Entering a Displacement Value  
 

You can specify a new displacement length during or directly following a 
move operation. To enter a displacement value during a move operation:  

 

1.  Select the Select  tool ( ). The cursor will change to an arrow.  

2.  Select the entities to be moved.  

3.  Select the Move  tool ( ). The cursor will change to a four -way 

arrow.  

4.  Click once to select the start point of the move operation.  

5.  Move your mouse to begin moving the entities in the correct 

direction. The selected entities will follow as you move your mouse. 

Also, an inference  line will appear between the start and ending 

points of the move, and the distance of the move is displayed 

dynamically in the Measurements toolbar .  

 
Type the positive or negative displacement value (such as 20' or -35mm) 

in the Measurements toolbar  and press the Enter  (Microsoft Windows) or 

Return  (Apple macOS ) key.  
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Note: You can type values in the Measurements toolbar  using an alternate 
measuring system than the default system. SketchUp will convert the value 

to the default system. For example, you can type in 3' 6" even if you are 

using metric system as your default.  

 

Entering a 3D Coordinate  
 

SketchUp can move your entities to exact (using [ ]) o r relative (using ) 

coordinates in 3D space. To enter a 3D coordinate during a move 
operation:  

 

1.  Select the Select  tool ( ). The cursor will change to an arrow.  

2.  Select the entities to be moved.  

3.  Select the Move  tool ( ). The cursor will change to a four -way 

arrow.  

4.  Click once to select the start point of the move operation.  

5.  Move your mouse to begin moving the entities in the correct 

direction. The selected entities will follow as you move your mouse. 

Also, an inference  line will appear between the start and ending 

points of the move, and the distance of the move is displayed 

dynamically in the Measurements toolbar .  

6.  Type the exact or relative coordinate.  

 

Global Coordinates: [x, y, z] of the current Sketch Axes:  
 

 
Relative Coordinates: relative to the start point:  

 
 

 

Note: You can define only one or two values as part of your 3D coordinate. 

For example, to move geometry to 2 feet in the z or blue direction enter the 

following in the Measurements toolbar : [ ,,2' ]  

 

Note: The exact format for values typed in the Measurements toolbar  will 

vary depending on your computer's regional settings. For some European 
users, the list separator symbol is a semi -colon instead of a comma. For 

example, [x; y; z]  
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Push/Pull Tool 
 
Push and pull Face entities to add or subtract volume from your 3d 

models.  
 

Tool Operation  
 

1.  Hover cursor to select a face.  

2.  Move cursor to push or pull face into 3D form.  

3.  Click to finish push/pull operation.  

4.  Esc = Cancel operation.  

 

Pre - Pick Tool Operation  
 

1.  Use Select tool to select a face.  

2.  Activate Push/Pull tool.  

3.  Click once to set start point of Push/Pull.  

4.  Click to finish push/pull.  

5.  Esc = Cancel operation and clear selection.  

 

Modifier Keys  
 

Å Ctrl = Tog gles creating new starting face  

Å Alt = Push/Pull while stretching attached faces  

 

 Push/Pull tool introduction  
 

Use the Push/Pull tool to push and pull Face entities to add volume to or 
subtract volume from your models. You can use push/pull to create 

vo lume out of any face type, including circular, rectangular, and abstract 
faces. Activate the Push/Pull tool from the Tool Palette ( Apple macOS ), 

the Modification toolbar  (Microsoft Windows) or the Tools menu.  
 

Keyboard Shortcut: P 
 

Note: Push/Pull works only on faces, and therefore does not work when 

SketchUp is set to a Wireframe rendering style.  

 

 Repeating a Push/Pull operation  

 
Double -clicking on another face immediately after a push/pull operation 

will automatically apply another push/pull ope ration, of the same amount, 
to the other face.  
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Note: The side of the face that you double -click on affects the direction of 
the repeated push/pull operation. If your last push/pull was on a front face, 

and you double -click on the back side face, the push/p ull will occur in the 

opposite direction.  

 

 Creating voids  

 
Push/pull will implode the shape into the volume and toward the back face 

of the volume when you use push/pull on a shape that is part of another 

volume. SketchUp will subtract the shape and crea te a 3D void if the 
shape is pushed completely out of the back of the volume as in the 

following example.  
 

 
 

 
 

 
 

 
 

 
 

 

 
 

Note: This operation only works when the front and back faces are parallel. 

Such as when you have two parallel walls in a house and you want to create 

a void for a door or window.  

 

 Creating a new Push/Pull starting face  
 

Push/pull a face (click on the face, move, and then click again) and then 

press and release Control (Microsoft Windows) or  Option (Apple macOS ) 
(the cursor will contain a plus sign) and  push/pull again. The lines that 

represent the edges of the top -most face will remain as the starting point 
for a new push/pull operation.  

 
This mechanism is useful for creating quick multilevel buildings.  

 
The following image sho ws a face that was pulled up (left), then the user 

pressed and released Ctrl (Microsoft Windows) or Option ( Apple 
macOS )and pulled again (middle) and then the user pressed and released 

Ctrl (Microsoft Windows) or Option ( Apple macOS ) and pulled again 
(righ t).  
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This operation is particularly useful for creating quick space planning 

diagrams (such as for an office building). Simply use a combination of 
push/pull and push/pull with Ctrl to create offices, halls, break rooms, 

meeting rooms and so on (with walls created when Ctrl is pressed).  
 

 Pushing and pulling a curved face  

 
You can use the Push/Pull tool on faces that have an arc as an edge 

similarly to using the Push/Pull tool on regular faces. The curved face that 
results from the push/pull operation is called a Surface entity. Surfaces 

can be adjusted as a whole, but are comprised of a number of faces or a 
curved face set.  

 

 
 

Tip: Select View > Hidden Geometry to view and manipulate the individual 

faces in the surface.  

 

 Pushing and pulling precisely  

 
The displacement of a push/pull operation is displayed in the 

Measurements toolbar . You can specify an exact push/pull value either 
during or immediately after your push/pull operation. Negative values will 

perform the push/pull in t he opposite direction.  
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Rotate Tool  
 

Rotate, stretch, distort, or copy entities along a rounded path.  
 

Tool Operation  
 

1.  Click on entity.  

2.  Move cursor in circle until it is at staring point of rotation.  

3.  Click to set starting point of rotation.  

4.  Move cursor in circle until it is at ending point of rotation.  

5.  Click to complete rotation.  

 

Modifier Keys  
 

Å Shift (before first click) = Lock tool t o current orientation  

Å Ctrl = Toggles rotated copy of selection  

 

 Rotate tool introduction  
 

Use the Rotate tool to rotate, stretch, distort, or copy entities along a 
rounded path. Activate the Rotate tool from the Modification toolbar  

(Microsoft Windows) , the Tool Palette ( Apple macOS ) or the Tools menu.  
 

Keyboard Shortcut: Q  
 

 Making rotated copies  

 
The Rotate tool can be used to make rotated copies of entities within your 

model. To make copies of an entity using the Rotate Tool:  

 

1.  Select the Rotate  tool ( ). The cursor will change to a protractor 

with a circular arrow.  
2.  Click on the entity to rotate.  

3.  Press and release the Ctrl  (Microsoft Windows) or Option  (Apple 
macOS ) key on your keyboard. The cursor will change to a 

protractor with a plus sign. This action informs Sketchup that you 

want to duplicate the entity.  
4.  Move the cursor in a circle until it is at the starting point of the 

rotation.  
5.  Click to set the starting point of the rotation. Use the inference tool 

tips to help you to find the center of the rotation.  
6.  Move the cursor until it as at the ending point of the rotation. A copy 

of the entity appears and is rotated about the starting po int. If the 
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'Enable angle snapping' checkbox is checked in the Units Panel of 

the Model Info dialog box, movements close to the protractor result 
in angle snaps, while those further away from the protractor allow 

free rotation.  

7.  Click to complete the rotation.  

 

Note: Press and hold the Ctrl  (Microsoft Windows) or Option  (Apple 

macOS ) key at any time during a move operation to perform a copy (not 

just at the start).  

 

 Creating multiple rotated copies  (radial arrays)  

 
The Rotate t ool can also be used to create radial arrays, or a series of 

copies around a rotate point. To create a radial array.  
 

1.  Select the Rotate  tool ( ). The cursor will change to a protractor 

with a circular arrow.  

2.  Click on the entity to rotate.  

3.  Press and release the Ctrl  (Microsoft Windows) or Option  (Apple 

macOS ) key on your keyboard. The cursor will change to a 

protractor with a plus sign. This action informs Sketchup that you 

want to duplicate the entity.  

4.  Move the cursor in a circle until it is at the starting point of the 

rotation.  

5.  Click to set the starting point of the rotation. Use the inference tool 

tips to help you to find the center of the rotation.  

6.  Move the cursor until it as at the ending point of the rotation. A 

copy of the entity appears and is rotated about the starting point. 

If the 'Enable angle snapping' checkbox is checked in the Units 

Panel of the Model Info dialog box, movements close to the 

protractor result in angle snaps, while those further  away from the 

protractor allow free rotation.  

7.  Click to complete the rotation.  

8.  Type a multiplier value to create additional multiple copies. For 

example, typing in 2x  (or *2 ) will create one additional copy (or 2 

copies total, the one you manually copied  plus one you 

automatically copied using this step) instead of just one.  
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Note: Press and hold the Ctrl  (Microsoft Windows) or Option  (Apple 

macOS ) key at any time during a rotate operation to perform a copy (not 

just at the start).  

 

Creating copies at an equal distance apart  
 

You can divide the distance between the copy and the original by typing in 

a divisor value in the Measurements toolbar . For example, typing 5/  (or 
/5 ) will create five copies evenly distributed between the origin al and the 

first copy. You can enter distances and multipliers until you perform 
another operation.  

 

 Folding along an axis of rotation  

 

You can fold geometry by setting the protractor along an edge that will act 
like a fold line and then folding geometry  at that line. To fold geometry 

along an axis of rotation:  
 

1.  Select the Select  tool ( ). The cursor will change to an arrow.  
2.  Select the geometry to rotate. The bottom of the triangle will act as 

a fold line.  

 
 

3.  Select the Rotate  tool (      ). The cursor will change to a protractor 

with a circular arrow.  
4.  Click and hold on one end of the fold line or edge where the fold will 

appear in your geometry.  

5.  Drag the cursor along the fold line to align the protractor to the fold 

line (the bottom of the triangle).  

 

 
 

 
 

 
  

6.  Release the mouse button to set the rotation point or the point upon 
which the geometry will rotate.  
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7.  Click the mouse again to set the starting point of the rotation.  

 
8.  Move the mouse to rotate. If angle snaps are active under 

preferences, you'll notice t hat as you move the mouse, movements 
close to the protractor will result in angle snaps, while those further 

away from the protractor will allow free rotation.  

 
9.  Click a third time at the ending point of the rotation (to complete 

the rotation).  

 

 
 

 
 

 
 

 

 Rotating precisely  
 

The degree of rotation you have indicated appears in angular degrees in 
the Measurements toolbar  while rotating. You can also manually enter in 

angular rotation or slope values directly into the Measurements toolbar  
while rotating geometry.  

 
Entering an angular rotation value  

 

To specify an exact angle in degrees, type a decimal value into the 
Measur ements toolbar  while rotating the cursor around the protractor. For 

example, typing in 34.1  will give you an exact 34.1 degree angle. 
Negative values will move angle in a counter -clockwise direction. You can 

specify an exact angular value either during or immediately after your 
rotation operation.  
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Entering a slope value  
 

To specify a new angle as a slope, type in the two values separated by a 
colon in the Measurements toolbar , such as 8:12 . Negative values will 

move angle in a counter -clockwise direction. You can specify an exact 
angular value either during or immediately after your rotation ope ration.  
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Scale Tool  
 
Resize and stretch portions of geometry relative to 

other entities in model.  
 

Tool Operation  
 

1.  Click on an entity (lines cannot be scaled).  

2.  Click on a scaling grip.  

3.  Move cursor to scale entity.  

4.  Click to finish offset operation.  

 
Modifier Keys  

 

Å Shift = Scale uniformly  

Å Ctrl = Scale about the geometry's center  

 

 Scale tool introduction  

 

Use the Scale tool to resize and stretch portions of geometry relative to 
other entities in your model. Activate the Scale tool from the Modification 

toolbar , the Tool Palette or the Tools menu.  
 

Keyboard Shortcut: S 
 

Note: A Global Scale is an operation w hereby the entire model is scaled 

simultaneously by applying a desired dimension to the distance between 
two points. The Scale tool is only intended to perform scaling operations on 

portions of your model (not the entire model). Use the Tape Measure Tool's  

global re -scale functionality to perform global scaling operations.  

 

 Scaling 2D surface or image entities  

 
Two -dimensional surfaces and Image entities can be scaled just as easily 

as three -dimensional geometry. The scale tool's bounding box contains 
nine scaling grips when scaling a 2D face. These operate in a similar 

manner to the grips in a 3D bounding box, and also work with the 

Command (Microsoft Windows) or Option ( Apple macOS ) and Shift 
modifiers.  

 
The bounding box is a 2D rectangle whe n scaling a single 2D surface that 

lies in the red -green plane. The bounding box will be a 3D volume if the 
surface to be scaled is out of plane with the current red -green plane. You 

can ensure a 2D scale by aligning the Drawing Axes to a surface prior to 
scaling.  
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 Scaling components  

 
Scaling a Component entity scales the individual instance. All other 

instances of the component will retain their individual scales. This feature 
allows you to have many differently scaled versions of the same 

component in y our model.  
 

Scale operations within a component's context (such as scaling a Line 
entity within a component) affects the component definition and, 

therefore, all instances of the component are scaled to match (all 
instances of the same Line entity in all c omponent instances).  

 

 Scaling about the geometry center  
 

The Scale tool allows you to scale outward from geometry's center point. 
Press and hold the Control (Microsoft Windows) or Option ( Apple macOS ) 

key at any time during a scale operation to display the geometry's center 
point, click on any of the other scaling grips, and drag outward or inward 

to scale accordingly.  
 

 Scaling uniformly  

 
You might need to maintain the uniformity of geometry as it is being 

scaled, despite performing nonuniform scaling. The Shift key toggles to 
uniform scaling operation (from a nonuniform scaling operation) and to 

nonuniform scaling operation (from a uniform scaling operation).  
 

Note: The Ctrl (Microsoft Windows) or Option ( Apple macOS ) and 'Shift' 

keys to allow uniform and non -uniform scaling from the center of the 

selected geometry.  

 

 Controlling scaling direction with the Axis tool  

 
You can precisely control the direction of scaling by first repositioning the 

drawing axes with the Axes tool. The Scale tool wil l use the new red, 
green, and blue directions to orient itself, and control grip direction, after 

the axes are repositioned . 
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 Scaling precisely  

 
The Measurements toolbar  at the bottom right corner of the SketchUp 

window displays the axis dimensions that are being scaled, and the value 
of the scale itself, in the default units (as specified under the Units panel 

of the Model Info dialog box) during a scaling operation. Typ e a scale 
value into the Measurements toolbar  to directly scale geometry during or 

immediately after a scaling operation.  
 

Entering a scale multiplier value  
 

You can specify a new dimensional length value during or directly 
following a scaling operation. T o enter a dimensional length value during a 

scaling operation:  

 

1.  Select the Select  tool ( ). The cursor will change to an arrow.  

2.  Select the geometry to scale.  

3.  Select the Scale  tool ( ). The cursor will change to a box within 

another box. Scaling grips will appear around the selected 

geometry.  

4.  Click on a scaling grip to select the grip. The selected grip and the 

opposite scaling grip will highlight in red. Each scaling grip provides 

a different scaling operation. See Scaling Options section for further 

information.  

5.  Move the mouse to scale the geometry. The Measurements toolbar  

displays relative size of the item as you scale the item. You can 

enter the desired scale dimensions after the  scale operation is 

complete.  

6.  Type the dimensional length value (such as 2' 6" for two feet and six 

inches or 2m for two meters) in the Measurements toolbar  and press 

the Enter  (Microsoft Windows) or Return (Apple macOS ) key.   

 
Mirroring geometry using th e Scale tool  

 
The Scale tool can also be used to mirror geometry by pulling a grip 

towards and then beyond the point about which you are scaling. This 
operation allows you to pull geometry inside out. Note that the grips snap 

to certain negative values (su ch as -1, -1.5, and -2) just as they do in the 
positive direction. You can force a mirror by typing in a negative value or 

dimension.  
 

Entering multiple scale values  
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The Measurements toolbar  always indicates the scaling factors associated 

with a particula r operation. A 1D scaling operation requires one value. A 
2D scaling operation requires two values, separated by a comma. A 

Uniform 3D scaling operation requires only one value whereas a Non 
Uniform 3D scaling operation requires three values, each separate d by a 

comma.  
 

You'll notice that during the scale operation, a dashed line appears 

between the scaling point and the grip you've selected. Entering a single 
value or distance in the Measurements toolbar  tells SketchUp adjust the 

anchor to grip distance to  be that scale value or distance, regardless of 
which mode (1D, 2D, 3D) is active.  

 
When scaling in multiple directions, typing in multiple values separated by 

commas will resize the object(s) based on the entire bounding box 
dimension(s), not the objects individually. (To scale objects based on a 

particular edge or known distance, you can use the Tape Measure tool.)  
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Offset Tool  
 
Create copies of lines at a uniform distance from 

originals.  
 

Tool Operation  
 

1.  Click on a face.  

2.  Move cursor.  

3.  Click to finish offset operation.  

4.  Esc = Cancel operation.  

 
Modifier Keys  

 
None.  

 

Offset tool introduction  

 
Use the Offset tool to create copies of lines and faces at a uniform 

distance from the originals. You can offset edges of faces either inside or 
outside of the original face. Offsetting a face will always create a new 

face. Activate the Offset tool from the tool Palette ( Apple macOS ), the 
Modification toolbar  (Microsoft Windows) or from the Tools menu.  

 
Keyboard Shortcut: F  

 

Offsetting lines  

 

You can also select and offset connected, co -planar, lines (and arcs) for an 
offset. To offset lines:  

 

1.  Select the Select  tool ( ). The cursor will 

change to an arrow.  

2.  Select the lines to be offset. You must select two 

or more connected lines, and all your lines must be 

coplanar.  

3.  Select the Offset  tool ( ). The cursor will 

change to two offset corners.  

4.  Click on one of your selected line segments. The 

cursor will automatically snap to the nearest line 

segment.  

5.  Move the cursor to define the offset dimension  

6.  Click to finish the offset operation.  
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Tip: You can click once on the selected line segments, drag  to set the offset 

while holding down the mouse button, and release the button to accept.  

 

Note: Offsetting an Arc entity will create a Curve entity that cannot be 

edited. The original Arc, however, can still be edited after this operation.  

 

Repeating an offset operation  
 

Double -clicking on another face immediately after a offset operation will 
automatically apply another offset operation, of the same amount, to the 

face.  
 

Offsetting precisely  

 
The Measurements toolbar  at the bottom right corner of the Sk etchUp 

window displays the length of the offset in the units as specified under the 
Units panel of the Model Info dialog box, while offsetting entities. You can 

also specify an exact offset during, or immediately after, an offset 
operation.  

 

Note: You can type values in the Measurements toolbar  using an alternate 
measuring system than the default system. SketchUp will convert the value 

to the default system. For example, you can type in 3' 6" even if you are 

using metric system as your default .  

 
Entering an Offset Value  

 
You can specify a new offset length during or directly following an offset 

operation. To enter an offset value during an offset operation:  
 

1.  Select the Select  tool ( ). The cursor will change to an arrow.  

2.  Select the lines to be offset. You must select two or more connected 
lines, and all your lines must be coplanar. Use the Command 

(Microsoft Windows) or Option  (Apple macOS ) and/or Shift key to 
change your selection.  

3.  Select the Offset  tool ( ). The cursor will change to two offset 

corners.  
4.  Click on one of your selected line segments. The cursor will 

automatically snap to the nearest line segment.  
5.  Move the mouse to define the offset dimension.  

6.  Click your mouse to a ccept the offset lines.  

7.  Type the positive or negative offset value (such as 20' or -35mm) in 

the Measurements toolbar  and press the Enter  (Microsoft Windows) 

or Return  (Apple macOS ).  



SketchUp User Manual ï version 19.   83 /211  

 

  

Follow Me Tool  
 
Duplicate a face along a path.  

 
Tool Operation  

 

1.  Identify edge of geometry to modify. This edge is the path.  

2.  Draw a face perpendicular to path.  

3.  Click on Follow Me tool.  

4.  Click on face.  

5.  Drag cursor to end of path.  

6.  Click to complete Follow Me operation.  

7.  Esc = Cancel operation.  

 

Modifier Keys  

 
Alt = Use perimeter of surface as the path  

 

 Follow Me introduction  

 
Use the Follow Me tool to duplicate the profile of a face along a path. This 

tool is especially useful wh en trying to add details to a model, such as a 

crown molding, because you can draw the profile of the molding at one 
end of a path on the model and using the Follow Me tool continue that 

detail along the path. You can manually and automatically extrude a f ace 
along a path using the Follow Me tool. Activate the Follow Me tool from 

the Tools menu, the Modification toolbar  (Microsoft Windows), or the tool 
Palette ( Apple macOS ).  

 

Note: The path and the face must be in the same context.  

 

 Automatically extruding a face along a single surface path  
 

The simplest and most accurate way to extrude a face along a 
path is to have the Follow Me tool automatically select and 

follow a path on a single coplanar surface. To automatically 
extrude a face along a path on an single surface using the 

Follow Me Tool:  
 

1.  Identify the edge of the geometry you want to modify. 
This edge will be your path.  

2.  Draw a profile of the face that you want to follow the 
path. Make sure that this profile is app roximately 

perpendicular to the path.  
3.  Select the Tools > Follow Me.  
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4.  Press and hold the Alt (Microsoft Windows) or Command ( Apple 

macOS ) Key.  
5.  Click on the profile that you created.  

6.  Move the cursor off the profile surface onto the surface around 
which yo u wish to sweep. The path will automatically close.  

 

Note: If your path consists of the edges around a single surface, you can 

select the surface and then the Follow Me tool to automatically follow the 

edges around the surface.  

 

7.  Click to commit the follow -me operation.  

 Creating a lathed shape  
 

You can use the Follow Me tool to create full lathed shapes using circular 
paths. To create a lathed shape:  

 
1.  Draw a circle whose edge will represent the path.  

2.  Draw a face perpendicular to the circle. The face does not have to 
be on or even touch the circle's path.  

 
 

 

 
 

 
 

 
 

3.  Select Follow  Me tool ( ). The cursor will change to a slanted box 
with an arrow.  

4.  Follow the edge of the circle with the face using one of the methods 
above.  
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Intersect Tool 
 
Intersect all selected solids but keep only their intersection in the model.  

 
Intersect introduction  

 
Use Intersect  tool  to create complex geometry.  

 
This option allows you intersect two elements, such as a box and a tube, 

to automatically create new edges and faces where the elements 

intersect.  
 

These faces can then be pushed, pulled or deleted to create new 
geometry.  

 
Activate Intersect  from either context menu , the Edit menu  or the Solid 

Tools toolbar . 
 

 

  






























































































































































































































































